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MIND CASTLE: The Spell of the Word Wizard, is copyrighted and all rights are reserved by
Lawrence Productions, Inc. This product, including the software program, disks, packaging
and written materials, is intended for use by the original purchaser only. Copying, duplicating,
selling or otherwise distributing this product or reproductions of this product without the
express written permission of Lawrence Productions, Inc. are violations of U.S. Copyright Law
and are hereby expressly forbidden.

©Copyright 1993 by Lawrence Productions, Inc. All rights reserved. Printed in the U.S.A.

MIND CASTLE: The Spell of the Word Wizard, and MIND CASTLE are trademarks of Lawrence
Productions, Inc. IBM is a registered trademark of International Business Machines, Inc. Tandy is a
registered trademark of Tandy Corp. Microsoft, MS-DOS, and Windows are registered trademarks
of Microsoft Corp. AdLib is a registered trademark of AdLib, Inc. Sound Blaster is a trademark of
Creative Labs, Inc. Macintosh is a registered trademark of Apple Computer, Inc. All other trade
names mentioned in the program and documentation are trademarks of their respective owners
Use of any names without the ™ or ® symbol should not be construed as a challenge to ownership.
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INTRODUCTION

While taking a leisurely walk
through a crisp, green forest,
you stumble upon a deserted
castle. You have walked this
route several times, but you
don'tremember ever coming
upon this before! Can this be
real? It's certainly strange to
see a deserted castle appear
from thin air. Curiosity can
be dangerous, but you like
excitement and challenge, so
you begin to climb up the
ancient, winding stairway. As
you ascend, you are nabbed
by a mischievous, puzzle-
fabricating Wizard!

But Wait —

There is a Way Out. ..
The Wizard has hidden word
puzzles throughout his castle
to test your vocabulary skills
and knowledge, and the Wiz-
ard is uncompromising. He's
already captured a lackey,
Smedley, who couldn’t solve
the puzzles. Because he
failed, the Wizard made him
his court jester. Unfortunate-
ly, you were not as lucky.
The Wizard has turned you
into a frog. Bummer!

To regain your pleasing
human form, you need to beat
the Wizard at his own game!
By successfully solving word
puzzles and discovering hid-
den portals, you will teleport
to lower floors, and finally to
ground level. If you find the
final portal, you'll be trans-

formed to your normal self
and be given your freedom.

A Piece of Cake

The Wizard is crafty! As you
decend floors, his puzzles
become more numerous and

challenging. What’s more, you
only have two hours (local
castle time) to solve his mind
games and gain your freedom.
You can do it, can’t you?

SPECIAL

INSTRUCTIONS

IBM

Required Equipment:

e |IBM or 100% compatible
computer

e A hard disk with at least
800K free space

e A VGA or MCGA monitor
and graphics card capable
of displaying 256 colors in
320 x 200 resolution

¢ One 720K 3.5" disk drive
(see below if you have a
different size drive)

e 400K of regular memory
free

e MS-DOS or PC-DOS 3.1 or
higher

e A keyboard or Microsoft-
compatible mouse

MIND CASTLE: The Spell
of the Word Wizard con-
tains one 720K 3.5" disk.
(From now on, for the sake of
convenience, we’ll call the
program simply Word Wiz-
ard.) If you have only a 5.25"
disk drive, you may exchange

the 3.5" disk for a 5.25" disk
at no additonal cost. Please
send a note requesting the
exchange along with the 3.5"
disk, a copy of your sales
receipt, and your name and
address to: '
Lawrence Productions, Inc.
1800 South 35th Street
Galesburg, MI 49053-9687

Hard Drive Installation
Word Wizard has no on-
disk copy protection, but the
files on the original disks are
compressed. This means you
cannot run Word Wizard
from a floppy drive; you must
install it on a hard disk to
run the program. To install
Word Wizard on your hard
disk, follow these instruc-
tions:

1. Exit out of any programs
you may be running, in-
cluding Windows, the DOS-
shell, or any other menu-
type program.

2. Insert the disk into your A
drive. (You may install the
program from your B drive
as well; just substitute “B”
for “A” in these direc-
tions.)

3. Change to the A:\> prompt
by typing A:

4. Now type INSTALL (upper
case or lower, it doesn’t
matter).

5. Follow the on-screen
prompts for choosing a
drive and directory. (You
may install the program in
a different directory from
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WORDWIZ, which is the
default, by backspacing
over that name and substi-
tuting any name or path
you like.)

Starting Word Wizard

1. Exitany programs you may
be running, so that you are
at the DOS prompt (To run
Word Wizard from Win-
dows, consult your Win-
dows manualon how to run
DOS programs and how to
create a PIF.)

2. Change to the drive and
directory in which you in-
stalled Word Wizard
(i.e., type CD\WORDWI?Z).

3. Type WORDWIZ and press
Enter. The program will be-
gin loading. (Also, see Op-
tional Switches below.)

After the title screen, a brief
introductory sequence of
dialog boxes will appear.
These will set the scene and
give you brief instructions on
how to play. Once you’ve
played Word Wizard a time
Oor two, you may wish to skip
these introductory dialogs
and goright to the game. To do
so, press the ESC key while
the title screen is displayed.

Optional Switches
Word Wizard includes a
number of “switches” which

may be used when loading the
program. These switches are

designed to overcome hard-
ware incompatibilities or to
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give you optional control over
how the program runs on your
machine.

Switches can be used in any
combination, as many as you
need. To use a switch, add it
to the command line when you
begin the program; separate
each switch with a space. For
example, to run the program
with a keyboard and faster

screen fades, at the command
prompt type: WORDWIZ /K /F

The complete list of switches

follows:

/C If you have color VGA,
but see only grays.

/F  Provides faster fades on
fast video cards.

/G Fixes Genius version 7.X
mice.

/K Enables keyboard, and

“bypasses mouse check.
/M If you have a mouse but

don’t see a mouse cursor.

/P Changes screen fades to
speckle-clears (helps on
slower machines, or if
you just prefer speckles
to fades).

/S  Reduces flicker during
screen transitions on
slower video hardware.

Quitting

To quit Word Wizard, go to
the File Menu and choose
“Quit.” Alternately, you may
quit by pressing Control-Q
(shown as “AQ” in the File
Menu). In either case, if you
have a game in progress and

have not saved it, you will be

given an opportunity to do so
before returning to DOS.

Using a Mouse

If you have a mouse driver

loaded, Word Wizard will
automatically use it. The only ,
keys on your keyboard that r'
will be active are the ESC key ]
while the Title Screen is dis-
played, and the File Menu
command equivalents.

To selectan object or button
during play of the game, press
the left mouse button. (From
now on,whenever theword
select is used, it means to
move the cursor over the
objector button you want to
play and press the left mouse
button.)

'To see what objects in a room
contain puzzles, press and
hold the right mouse button.
Boxes will appear, outlining
each object. When you release
the mouse button, the boxes
will disappear and you can
select an object as above.

Using a Keyboard

Word Wizard will only en-
able the keyboard for game
play if you have no mouse
driver loaded, or if you start
the program with the /K
switch (see Optional
Switches above).

To move the cursor arrow on
the screen, use the arrow
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keys. The Down and Right ar-
rows move the cursor clock-
wise; the Up and Left arrows
move it counterclockwise.

To select a button or choose a
puzzle object, press the Enter
key or the Spacebar. (From
now on, if you're using the
keyboard,whenever theword
select is used, it means to put
the cursor over the object or
button you wish to play and
press the Enter key or the
Spacebar.)

To seewhatobjects in a room
contain puzzles, press the “S”
key. Boxes will appear, out-
lining each object. When you
press any other key the boxes
will disappear and you can
select an object as above.

To Activate the Menu Bar,
press the ESC key. Pressing
ESC again will return you to
the game.

Tomovearound the Saving and
Loading boxes, use all four
arrow keys. If you have more
than five saved games and
want to scroll through them,
go to the list using the Up
Arrow. Then press the Right
Arrow key to move the cursor
to one of the scroll arrows on
the right side of the window.
Now the Up and Down Arrow
keys will flip back and forth
between the Up and Down
scroll arrows. Press Enter or
the Spacebar, with the cursor

on a scroll arrow, to scroll
through the list in the direc-
tion the arrow is pointing.

Sound

Music in Word Wizard has
been programmed to AdLib
standards. If you have an
AdLib or Sound Blaster board,
you’ll get higher quality
sound. Other “compatible”
sound boards may work just
fine, but we cannot guarantee
their effectiveness. If you
have a compatible board that
does not work with Word
Wizard, consult your board’s
manual first, then call the
manufacturer for further
assistance if needed.

Troubled Rodents

Most mice claim to be Micro-
soft compatible, but a lot of
them simply are not. We have
made every effort to support
as broad a range of mice as
possible. If your mouse is one
of the few that does not work
with Word Wizard, try the
“/M” switch when starting the
program; if it still doesn’t
work, use the “/K” switch to
enable the keyboard instead.
(See Optional Switches,
above, for a complete list of
switches.)

Saving Games

Word Wizard allows you to
save as many games to disk as
you wish, provided you have
available space. You may save
a game to your hard drive, or

to a floppy in your A: drive.
Games on your hard drive are
placed in a SAVES subdirec-
tory so that they’re easy to
find and delete later, when
you no longer need them. (If
you installed the program by
using DOS copy commands and
unpacking the files manually,
make sure you also created
the two subdirectories, SAVES
and HI-SCORES, or the pro-
gram won'twork properly.)

To save a game in progress:

1. Go to the File Menu and
select “Save” or “Save As”.

2. Select SAVES directory (the
default) or A:, depending
on where you wish to store
your game.

3. Select the blank field above
the buttons to activate the
typing cursor.

4. Type a name of 8 characters
or less for your saved game,
then press ENTER.

5. Now select the SAVE button
to write your saved game to
disk.

Loading a Saved Game
Once you have successfully
saved a game, you may return
to it later at the point where
you stopped. To load a saved
game:

1. Go to the File Menu and
choose “Open”.

2. Select the name of your
saved game from the file
list. The currently selected
file is shown by a green
box surrounding the name.
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3. Select the Open button.
Your saved game will load
and you’ll be returned to
the main screen at the
point the game was saved.

The file list displays up to
five saved games at a time. If
you have saved more than five
games, you can scroll through
the list by selecting the up
and down arrows to the right
of the file list window.

The Special Menu
By selecting the Special Menu,

you can view the current list
of High Scores, or turn your
Sound off and on. The Sound
selection works as a toggle
switch. If there is a check-
mark beside it, your Sound is
on; if there is no checkmark,
Sound is off.

MACINTOSH

Required Equipment:

e Macintosh computer (of the
LC, II or Quadra families)

e A 256-color screen

e At least 2ZMB free on your
hard disk

e System 60.0.5 or later

Hard Drive Installation
The files on the distribution
disks are compressed, which
means you cannotrun the
program from the disks. To
install them on your hard
drive, please follow these
instructions:

1. First, turn off any virus
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protection programs, such
as Gatekeeper, you may
have running. These pro-
grams will only cause
spurious messages to ap-
pear during installation,
and in some cases may pre-
vent installation entirely.
[f you forget to turn them
off, ignore the messages
that come up and simply
continue. Both Word
Wizard and the installer
program have been thor-
oughly tested for known
viruses with the latest
programs available at the
time of release.

. Insert Disk 1 into your

floppy drive. Double-click
the Word Wizard 1 disk
icon, if necessary, to dis-
play its window.

. Copy the file named Word

Wizard Installer to your
hard drive by selecting the
Word Wizard Installer icon
in the Word Wizard 1 win-
dow and dragging it into
your hard drive window.
(Open your hard drive win-
dow firstg, if it isn’t already
open.) After copying the
Installer, close the Word
Wizard 1 window.

. Now double-click the Word

Wizard Installer icon in
your drive window. A
scrollable message window
will appear. Please read
this message before pro-
ceeding.

. When you're ready to pro-

ceed, click on Install.

6. You'll be prompted to in-
sert Disk 2; insert Word
Wizard Disk 2.

/. Follow the prompts for the
remaining disks. (At the
end of the process you will
be instructed to insert
Disk 1 for a second time).

8. When all the files are ex-
tracted, the installer will
return you to the desktop.
Drag the Word Wizard In-
staller icon from your hard
drive into the Trash; you
won’tneed itany more.

9. To begin play, open the
Word Wizard on your
hard disk, and double-
click the Word Wizard
icon.

Saving a Game

To save a game in progress, a
room view must be in the main
window. Pull down the File
Menu and choose Save or Save
As; then, type in a name for
your saved game.

Loading a Game

To load a saved game, double-
click on its icon in your Word
Wizard folder. If you are
already in the Word Wizard
program,youmay choose
Open from the File Menu and
then select the desired game
from the file dialog.

Please Note
If you turn off the "Bib" (i.e.,
border), in the Options Menu,

the game will run noticeably
slower.



HOW TO PLAY

If you're the type of person
who likes to discover how to

play on your own, stop read-
ing right now. For those of
you who'd like to have an
advantage over the Wizard,
continue reading.

To get back your human form,

you need to do three things:

e Solve vocabulary puzzles,

e Solve passwords, and

e Find secret portals to go
from floor to floor.

The Main Window

The Main Window is a view of
the room you currently occu-

py. If you select the Move
button, the view changes to a

map of the floor you are on.
Once you select a room desti-

nation, the floor plan changes
to a view of the new room.

Help Line

At the bottom of each Main
Window, a Help Line gives
your current location and
helpful hints, or an occa-
sional encouraging word, to
make your stay more pleasant.

The Castle Display

The Castle Display is located
on the right-hand side of the
screen. This area includes a
digital clock, score, password
clue, and alphabricks.

Portals
Secret portals allow you to
travel to the next floor. But

even if you discover their
location, they remain closed
untl you solve the password.

Password

Once you find the secret por-
tals, you can activate them by
solving the password in the
Castle Display. The Alpha-
bricks keep track of letters
you have earned or guesed.
You may solve the password at
any time on each floor, but to
get to the next floor you need
to solve the password AND
find the secret portal.

Time

At the beginning of the game,

you have two hours to get out

of the castle. On one of the

towers in the Castle Display

is a digital clock set at 2:00.

Every action you choose uses

up a certain amount of time:

e Trying a puzzle takes 2
minutes.

e Moving to a differentroom
takes 1 minute.

e Guessing password letters
takes 3 minutes per letter.

There's a way to have time
added to your clock: time
bonuses. When you solve a
hidden puzzle, the Wizard
may provide you with a time
bonus ranging from 6 to 15
minutes.

Managing your time well is
one of the small challenges in
the Wizard’s castle.

Individual Rooms

Each of the 20 rooms in this
five-story castle has a num-
ber of hidden puzzles. If you
are in an exploring mood, you
can try clicking on objects to
uncover a hidden puzzle. If
you do, Smedley, the Wizard’s
lackey, will provide you with
a vocabulary puzzle. If you
want to reveal the location of
the hidden puzzles in a room,
hold down the right mouse
button if you’re an IBM user;
Mac users hold down the
Option key. Once you release
the button, the displays will
vanish.

Hidden Puzzles
Once you find a hidden puz-

zle, you'll be given a vocabu-
lary problem. Each one is a
sentence incorporating a defi-
nition or a synonym of the
vocabulary word. Along with
the sentence, you'll be given a
choice of two to four answers.
If you pick the correct an-
swer, the Wizard will give you
a letter, a time bonus, or the
location of that floor's hidden
portal. Each letter you receive
will help you solve the pass-
word. If your answer is incor-
rect, the Wizard will explain
why.

Move and Guess Buttons
The Move button makes it
possible for you to travel on a
floor of the castle. Clicking on
this button, displays a floor
plan. A frog image of yourself
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indicates where you are on
the floor. By clicking on any
part of the floor plan, you can
move to thatroom. Once you
have discovered the portal, it
will appear on the floor plan.
When yvou have solved the
password, you can click on
the portal and go to the next
floor.

The Guess button allows you
to make a guess on the pass-
word. To make a guess, select
a letter you think is in the
word. Guessing is not always a
wise choice if you are con-
serving time.

Score

For every puzzle you solve
you earn 10 points. Every
time you go through a portal
you receive 50 points (except
the final portal, where you get
200 points). If you make it
out of the castle, you’ll earn a
point for every minute re-
maining on the clock. If you
score enough points, you may
be entered in the Wizard’s
Hall of Fame.

CURRICULUM
TARGETS and
ACTIVITIES

Target Subject Areas
Word Wizard is carefully
designed to promote learning,
to reinforce English sKkills,
and to expand a young user’s
vocabulary. Learning out-
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comes for the states of Florida Various uses in the classroom

and Texas were used for the
development of Word
Wizard.

IanguageArtsOb] ectives

Reinforces spelling

e Strengthens reading com-
prehension

e Practices using context
clues

e Aids in choosing the ap-
propriateword among
words of multi-meanings

Critical Thinking Skills

and Objectives

e Drawing conclusions

e Using problem-solving
skills

e Applying game strategies

Key Activities

e Strategy and planning
e Decision making

e Cooperativelearning
e Socialdevelopment

Classroom Activities
[t takes approximately 30

minutes to play a game. This
makes it convenient to rotate

students playing Word
Wizard. Once students be-
come more familiar with the

game, it will take less time to
play. One advantage of Word
Wizard is that students can
work independently (with the
Sound off), making no inter-
ruptions during seat work, or

reading group times.

include:

Turn off Sound and use as
part of your learning sta-
tion for Language Arts.
Use as an enrichment tool
for advanced students.
Have a weekly contest to
see which pair of students
solve a puzzle the fastest.
Create a bulletin board in-
troducing the Alphabricks,
using your own password
(vocabulary word) of the
day.

Create a bulletin board of
scrambled Alphabricks
consisting of bonus words
from your weekly vocabu-
lary list.




WARRANTY

Lawrence Productions, Inc. warrants this program to the original
purchaser for a period of 90 days from the date of purchase. If you

have problems with this software, Lawrence Productions will replace
it free of charge during the warranty period.

This warranty applies to the diskettes and physical components only,
not to the software program itself. Lawrence Productions is not

responsible for any damage resulting from misuse of the program, or
errors in the program itself.

Defective materials should be returned to:
Lawrence Productions, Inc.
1800 South 35th Street
Galesburg, MI 49053-9687
Phone: 616-665-7075

All returns must include the original distribution disks and a brief

description of the problem. Please be sure to include your name,
address and telephone number.

This warranty shall not apply to disks that have been damaged by
negligence, accident, improper or unreasonable use, or by any other
causes unrelated to defective materials or workmanship.

Please check warranty limitations in your state as some states have
different rulings. This warranty gives you certain legal rights which
may vary from state to state. Lawrence Productions, Inc. makes no
express or implied warranties other than those stated above.
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